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TINJAUAN MATAKULIAH 

Deskripsi Mata Kuliah 

Mata kuliah ini membahas Pemrograman Mobile. Pengantar Pemrograman Mobile, Cara 

Instalasi Clipse Dan Menjalankan Avd, Menghubungkan Eclipse Dengan Sdk, Relative 

Layout Dan Linear Layout, Dasar Button, Radio, Image, Spinner, Crud Database Sqlite. 

Manfaat Mata Kuliah 

Dengan mengambil mata kuliah Pemrograman Mobile ini, Mahasiswa dan mahasiswi 

mempunyai pemahaman dan pengetahuan mengenai Pemrograman Mobile, Secara 

Keseluruhan yaitu membuat project-project dan tugas- tugas sederhana pemrograman mobile 

android, sehingga akan diperoleh kemampuan dan pengetahuan dalam pemrograman mobile 

sesuai yang diharapkan. 

Tujuan Instruksi Secara Umum 

Setelah menyelesaikan penulisan buku mata kuliah ini, Mahasiswa dan mahasiswi dapat 

menguasai pemrograman mobile dasar dengan baik, dapat mengimplementasikan sesuai 

project dasar pemrograman mobile. 
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Tujuan Instruksional Khusus 

1. Mahasiswa Paham dan bisa Menjelaskan Tentang Pengantar Pemrograman Mobile 

2. Mahasiswa Dapat Memahami Tentang Mobile Device 

3. Mahasiswa Dapat Memahami Dan Menjelaskan Tentang Mobile Aplikasi 

4. Mahasiswa Dapat Memahami Dan Mampu Menjelaskan Framework Native 

5. Mahasiswa Dapat Mengerti Dan Menjelaskan Framework Multiplatform 

6. Mahasiswa Memahami Penggunaan Aplikasi Mobile 

7. Mahasiswa Memiliki Kemampuan Cara Instalasi Eclipse Dan Menjalankan Avd 

8. Mahasiswa Memiliki Kemampuan Menghubungkan Eclipse Dengan Android Sdk 

9. Mahasiswa Memiliki Kemampuan Membuat Android Virtual Device 

10. Mahasiswa Memiliki Kemampuan Membuat Relative Layout Dan Linear Layoute 

11. Mahasiswa Mampu Membuat Scroll View 

12. Mahasiswa Mampu Mendefinisikan Button 

13. Mahasiswa Mampu Membuat Dasar Button 

14. Mahasiswa Memiliki Kemampuan Radio Dan Image 

15. Mahasiswa Memiliki Kemampuan Spinner Dan Dialog 

16. Mahasiswa Memiliki Kemampuan Pengantar Activity 

17. Mahasiswa Memiliki Kemampuan Mengirim Data Menggunakan Intent 

18. Mahasiswa Memiliki Kemampuan Splash Screen 

19. Mahasiswa Memiliki Kemampuan Pengantar Sqlite 

20. Mahasiswa Memiliki Kemampuan Crud Database Sqlite 

21. Mahasiswa Memiliki Kemampuan Menampilkan Database Sqlite 
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Pedoman Secara Umum Penggunaan Dalam Buku 

Buku ini berguna dan bermanfaat untuk membantu mahasiswa dan mahasiswi agar 

mampu memahami dan mengetahui konsepPemrograman Mobile dasar secara keseluruhan 

Yaitu menjelaskan, memahami, membuat dan Mengaplikasikan Dalam Bentuk Project 

Pemrograman Mobile. Konsep tersebut tidak hanya dari sisi Software atau perangkat lunak 

semata yang akan dibangun dan di kembangkan, tetapi juga membahas dan mempelajari 

tentang lingkungan kerja hidup dari user. 
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BAB 1 

 
PENGANTAR PEMROGRAMAN MOBILE 

 
1.1. Pengantar Pemrograman Mobile 

 
Pemrograman mobile I ini adalah pembuatan dan pengembangan aplikasi yang berjalan 

pada perangkat bergerak atau mobile seperti handphone Smart Watch . Aplikasi mobile 

dikembangkan dan di buat untuk platfrom - Platform tertentu yang populer dan friendly saat 

ini adalah sistem operasi iOS dan sistem operasi Android. 

Contoh platform lain yang digunakan adalah sistem operasi Windows Phone, sistem 

operasi Mobile Technology, sistem operasi Mobile Device, sistem operasi Mobile 

Application & Kegunaan , serta Mobile Programming dan Mobile VS Mobile Web Apps VS 

Web VS Desktop, menggunakan Framework Native, menggunakan Framework Multi 

platform. 

Pemrograman Java adalah bahasa pemrograman yang digunakan dan Android Software 

Development Kit (SDK) sebagai fiture pengembangan . IDE (integrated development 

environment) atau tools yang bisa digunakan adalah software Eclipse, atau yang umum 

Android Studio. 
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1.2. Mobile Device 

 

 
1.3. Mobile Aplikasi 

 

 
1.4. Framework Native 

 
Framework adalah kerangka kerja pemrograman yang mencakup library atau 

perpustakaan kode, model perangkat lunak, Application Programming Interfaces (APIs), dan 

berbagai elemen lain yang dapat mempermudah proses pemrograman. Sebuah framework 

dapat digunakan untuk membangun sebuah aplikasi berbasis website maupun perangkat 

lunak. 

Arti framework bagi para programmer itu sangat penting lho, sebab kerangka kerja 

tersebut membuat pekerjaan mereka tidak hanya menjadi lebih mudah, tetapi juga lebih 

efisien. Mereka juga tidak perlu mengulang-ulang kode karena sudah ada library yang sudah 

digunakan. 
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beberapa fungsi dari framework yang dapat membuat proses pemrograman menjadi lebih 

mudah. Membuat koding lebih mudah dan efisien Aktivitas penulisan kode yang biasanya 

rumit dapat menjadi lebih sederhana berkat adanya framework. Programmer tinggal 

menggunakan library yang ada di dalamnya. Selain itu, demi menghemat waktu, kerangka 

kerja ini juga mengurangi resiko kesalahan koding dan membuat blok kode menjadi lebih 

pendek. 

Meningkatkan keamanan Penggunaan framework juga dapat melindungi aplikasi dari 

serangan siber seperti SQL injection, cross-site request forgery, hingga data tempering. 

Sebuah platform kerangka kerja sudah lengkap dengan fitur keamanan built-in dan 

mekanisme yang memproteksi website atau aplikasi dari ancaman keamanan. 

Memudahkan proses debug dan pemeliharaan aplikasi Bahasa pemrograman asli  

memiliki kekurangan dalam tingkat keterbacaan kode. Selain itu, ia juga  membutuhkan 

waktu yang cukup panjang dalam maintenance, sedangkan framework tidak. Ketika seorang 

programmer menggunakan kerangka kerja pada pembuatan aplikasi, ia bisa melakukan  

proses debug dan pemeliharaan dengan lebih baik. Setiap framework umumnya juga 

memiliki komunitas pengguna yang bisa kita gunakan untuk berdiskusi tentang permasalahan 

yang terjadi saat penggunaan framework tersebut. 

 

1.5. Framework Multiplatform 
 

 
Pahami dari kelebihan dan kekurangan pada sebuah platform menjadi pekerjaan awal 

sebelum memilih platform yg akan digunakan untuk pengembanan nanti nya . Pemilihan 
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sistem framework umumnya ditentukan dari bagaimana dan arah pengembanan aplikasi anda 

akan digunakan oleh user sebagai target penggunanya. Third-party frameworks ini dapat 

sangat berfungsi dan membantu, tetapi Third-party tidak selalu harus digunakan. 

Sistem Hybrid solusi dapat menjadi opsion salah satu pilihan yang dapat digabungkan 

mengenai kekurangan-kelebihan masing-masing pendekatan framework native or pendekatan 

web based. 

1.6. Pengguna Perangkat Aplikasi Mobile 

 
Worker alat kerja seperti, Mobile Worker Melakukan fungsinya pengecekan email, 

pengecekan jadwal, dan kondisi , memperbarui email dan kondisi terkini, Pertemuan atau 

rapat kerja, Mengatur pegawai Membaca atau menulis bisnis pada drive dokumen masing- 

masing . 

Keterbatasan Piranti Mobile dalam table dibawah ini 
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BAB 2 

 
INSTAL ECLIPSE DAN MENJALANKAN AVD 

2.1. Cara Instal Eclipse Dan Menjalankan AVD 

Proses instalasinya dibagi dalam beberapa tahap : 

1. Install Java 

2. Install Eclipse 

3. Install the ADT Plugin untuk Eclips 

4. Download dan Install Android SDK dan Emulato 

5. MembuatAplikasi “program pertama” 

 
 

2.1.1. Install Java 

 
Sebelum memulai langkah - langka instalasi Eclipse dan Android SDK pastikan 

computer Anda telah terinstal Java SE Development Kit (JDK). Setelahitu install java pada 

computer anda. 

 

 

 

 

 

 
2.1.2. Install Eclipse 

1. akses situs website eclipse kemudian download sesuai kebutuhan, jika yang di 

iningkan versi 32 bit, maka download eclipse versi 32, jika yang dibutuhkan eclipse 

versi 64 makan download versi 64, sesuaikan dengan OS masing- masing yang 

digunakan. 
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2. Hasil download file berbentuk .zip , selanjutnya di uncompress file tersebut dengan 

aplikasi tambahan winzip atau winrar. Setelah di extrak akan muncul hasil folder 

eclipse, kemudian pindahkan folder tersebut kelokasi yang mudah di akses . 

 
 

 
Eclipse tidak memerlukan instalasi. Dalam folder eclipse ada file eclipse extensi exe. 

Klik file tersebut secara otomatis akan berlajan sendiri plug n play. 

 
2.1.3. Install the ADT Plugin untuk Eclipse 

 
Selanjutnya melakukan instalasi plug in ADT eclipse dan computer terhubung 

keinternet 

1. Klik menu pilihan Help selanjutnya Install New Software. 

2. Klik Add selanjutnya pada sudut kanan atas dialog 

3. Pada dialog Add selanjutnya repository. 

4. Masukkan name “ADT Plugin“, lalu selanjutnya masukkan URL 

5. https://dl ssl.google.com/android/eclipse/ 

6. Setelah itu klik OK . (kemungkinan agak perlu sedikit waktu) 
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Jika terdapat kendala saat mengunduh plug ini,coba ganti alamat link https dirubah 

dengan http jika muncul warning. Klik bawah kita percayai paket yang digunakan. 

 

7. Pada dialog Available Software, pilih checkbox Developer Tools (otomatis android 

DDMS dan android development kit akantercentangjikaandamencentang developer tools), 

kemudianklik Next dan Next. Tungguhinggaselesaidanklik button Finish. 
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8. Setelah selesai proses, restart Eclipse Anda. 
 
 

 
Langkah selanjutnya setelah restart aplikasi eclipse kita harus mengkonfigurasi ADT 

agar dikenali oleh sistem dengan mengarahkan ke direktori tujuan android yang telah 

didownload pada langkah pertama tadi. 

 

2.1.4. Download dan Install Android SDK dan Emulator 

 
Cara konfigurasi Android SDK untuk eclipse: 
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1. Langkah awal download file android dan SDK, sertakan pada folder eclipse yang di 

copy ke sistem. 

2. Dalam halaman tersebut ada 2 pilihan installer,jika yang dipilih exe. Maka nantinya 

akan melakukan instalasi dengan mengeksekusi file.exe,jika yang dipilih file zip, 

maka akan melakukan instalasi dan cukup lakukan uncompress. Kedua file  

dalamnya terdapat file yang sama tidak memiliki perbedaan. 

 

 
3. Untuk menjalankan tutorial ini akan lebih mudah jika mahasiswa  mendownload 

versi Android SDK yang memiliki ekstensi .zip. Dengan demikian mahasiswa hanya 

tinggal mengekstrak file .zip tersebut. 

4. hasil dari unkompres file extensi .zip tersebut merupakan sebuah folder dengan nama 

android-sdk winwows. Letakan atau pindahkan folder tersebut dimana saja agar 

mudah di akses.misalkan di folder yang sudah ada sebelumnya. 

5. Pastikan Anda sedang terhubung ke internet. Lakukan langkah Eksekusi file SDK 

Manager.exe, langkah selanjutnya klik button Update All untuk melakukan 

updateing library pada tools android secara otomatis hingga proses selesai. Proses ini 

akan memakan waktu cukup lama apabila jika Anda ingin memasang semua 

perangkat library untuk berbagai jenis tipe sistem operasi Android yang tersedia, 

karena jika semuanya terinstal kurang lebih akan memakan 2GB harddriveAnda. 
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Sebenarnya ada cara lain agar Anda tidak perlu melakukan update via online, yaitu secara 

offline. Caranya yaitu dengan melakukan copy paste seluruh folder dan file android-sdk- 

windows milik orang lain yang sudah berhasil terinstall, atau dapat juga mencari di google 

bagaimana cara menginstall android SDK secara offline, pada artikel ini saya tidak sertakan 

tutorial secara offline karena saya menginginkan agar anda dapat membuat aplikasi tidak 

hanya pada ginger bread namun dapat digunakan di ice cream sandwich juga 

 
a. Langkah – langkah menghubungkan tols Eclipse dengan sitem Android SDK : 

1. Buka Eclipse, kemudian masukke menu Window -> Preferences, laluklik Tab 

Android 

2. Pada dialog tersebutklik button Browse, kemudian arahkanke path/lokasi folder 

android-sdk-windows Anda. 

3. Pilih Apply, maka akan muncul beberapa macam library yang siap digunakan, seperti 

tampak pada gambar berikut. 
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4. Klik OK 

 
Menambah platform pada android dan fiture lain seperti pada cara dibawah ini: 

 
a. Manager.exe yang ada pada direktori system >android>sdk>windows jalankan SDK 

Manager 

b. Pada bagian fiture available package, centang tanda SDK Platform android yang 

dihenedaki 

c. Klik Install Selected untukmengunduhkemudianpadakotak dialog selanjutnyaklik 

install. 

 

Membutuhkan minimal 1 platform agar bisa mengembangkan aplikasi android 

disesuaikan dengan versi berapa anda ingin mengembangkan aplikasi. Anda dapat 

mencentang platform sesuain komponen lain berupa document, sample, usb driver,google api 

untuk di unduh. 

 

Meskipun instalasi minimal 1 platform di rekomendasikan,namun tidak wajib. Jika 

tersedia api yang lebih baru dari yang telah ada di direktori, biasanya api yang versinya lebih 

baru mendukung versi api dibawahnya,namun sebaliknya pada versi api yang lebih lama 

tidak cocok di gunakan untuk versi api lebih baru. 
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Jika terdapat kotak “Choose Package to Install” muncul dengan automatis, pastikan anda 

melakukan mencentang hanya yang anda perlukan saja untuk menghindari proses download 

yang lama . Anggapannya (default-nya), semua platform android akan tercentang. 

Mengunduh semua platform yang di sesiakan akan memakan waktu yang cukup lama. 

 

2.1.5. Membuat Aplikasi AVD (Android Virtual Device) 

Setelah proses install flat dan form selesai selanjutnya kita harus mengkonfigurasi AVD 

terlebih dahulu dengan caranya: 

-Klik menu windows selanjutnya Android SDK dan AVD Manager. 

-Pastikan prosess dalam download platform sudah selesai dikarenakan dalam proses 

konfigurasi AVD ini memerlukan satu buah platform minimal untuk proses run. AVD 

mendefinisikan system image dan setting device yang digunakan Emulator 

-Pilih Virtual Device (sebelah kiri atas) kemudian klik New (sebelah kanan atas) 
 

 

 
-Isi pada kolom nama dan pilihlah pada kolom Target 
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Sampai disini semua proses konfigurasi android di sistem sudah selesai, dan Anda 

sudah siap untuk melakukan uji coba membuat awal aplikasi Android menggunakan  

software Eclipse. 

 

 
Langkah selanjutnya yaitu membuat project baru dan mencoba untuk menjalankannya 

 
Untuk penggunaan Eclipse maupun Android studio untuk pertama kali, kita akan 

diminta untuk menentukan lokasi SDK ( software development kit) dan Workspace ( letak 

penyimpanan projek android ) .Untuk eclipse silahkan ikuti langkah berikutini : 

Cara setting Lokasi SDK Buka eclipse pada menu Window -> Preferences 
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Setting Workspace 

3. cari letak SDK kemudian OK 

4. setelah klik Apply 

akan muncul list 

Target Android yang 

terdapat pada SDK 
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Workspace merupakan letak projek disimpan 
 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 
Membuat AVD 

 
Klik tab Window  Virtual Device Manager  Create 

2 

3 

1 

6 

5. Arahkan workspace ke folder 

workspace di folder eclipse 

7 

4 
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Isikan seperti berikut ini : untuk nama AVD silahkan mau diberi nama sesuai keinginan 

anda. 

 

 
Setelah selesai klik Setiap menjalankan klik nama emulator  start 
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Sebaiknya emulator jangan ditutup selama kita masih membuat program. Karena load 

awal emulator relatif lama. 

Memulai Eclipse menggunakan ADT 23.0 dengan SDK. 

 
Berikutiniadalah tutorial untukmemulaimembuat Project barudenganEclipse. 

 
Klik File  New  Project 
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Pilih Android Android Application Project 

 

 
TentukanNamaAplikasi, Nama Project, NamaPakckage 
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Membuat Icon Aplikasi (bisaberupaGambar, Clipart, maupun Text) 

Versi Compiler 

Versi Target Android 

VersiMinumal Android 

Biarkancentangjikainginmenyimpanprojectnya di 

workspace. hilangkancentangjikainginmenyimpandiluar 

workspace. Mis: FDD 
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Pilih Blacnk Activity Untuk Membuat Halaman Baru 

 

 
Ketikan nama activity name yang di inginkan 
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Jika saat muncu lpertama kali 

 
Tidakadatampilan preview Graphical Layoutpada activity_main.xml 

 

 
Klik Compact Menu pilih Holo.LightTheme.Holo.Light.CompactMenu 

Atau klik android version ( gambar android ) pilihAPI 17 : Android 4.2.2 

Project 

baruterbe 

ntuk 
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Konfigurasi api versi yang akan digunakan untuk run hasil compile code 

 

 
Halaman utama menu mainactivity untuk memulai membuat project android 

 

Tampilan 

preview 
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Membuat class/activity danmembuat layout Baru 

 
Padaawalmembuat project kitaakanmempunyai 1 class ( MainActivity.java )dan 1 layout 

(activity_main.xml ) 

1. Membuat Class (contoh:Nama.java)  

Klikkananpada Package  New  Class 

 

 
MemberikanNama Class 
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1. Membuat Layout (contoh:layout_1.xml) 

Klikkananpada Package  New  Other 

Nama Class 

biasanyaberawalanKapitaluntukmemu

d ahkankarenabiasanyanama 

class/activity 

Class Nama.java terbentuk 
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Android  Android XML Fileatau Android Layout File 
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2.2. Cara mengimport (membuka project) yang pernah dibuat. 

 
Buka Eclipse .. File  Import 

 

 
Muncul pop up. Pilih Android  Exiting android Code Into Workspace  next 

Biasanyaberhurufkecildansp 

asidigantigarisbawah 

Terbentuk layout baru 
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Browse  pilih letak project yang pernah dibuat  OK 
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Jika dalam import ada tanda merah (kesalahan) maka project harus di pindah di 

workspace. Hapus project yang ada di package explorer 

Centang jika ingin mengcopy project ke workspace. 

Jangan centang jika ingin hasilnya nanti tetap berada di 

directory sumbernya 
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Ada 

kesalahan 

proses 

import 
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di centang ingin menghapus keseluruhan hingga di 

disk nya. 

Jangan di centang jika hanya untuk menghapus dari 

project explorer 

 

 

 

 

 

 

Untuk penggunaan Eclipse maupun Android studio untuk pertama kali, kita akan diminta 

untuk menentukan lokasi SDK (software development kit) dan Workspace (letak 

penyimpanan projek android) .Untuk eclipse silahkan ikuti langkah berikut ini : 

2.3. Cara setting Lokasi SDK 

 
Buka eclipse pada menu Window -> Preferences 
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Setting Workspace 

 
Workspace merupakan letak projek disimpan 

3. cari letak SDK kemudian 
OK 

3 

2 

1 
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6 

5. Arahkan workspace ke folder 

workspace di folder eclipse 

7 

4 
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BAB 3 

MENGENAL ANTAR MUKA 

3.1. Variabel dan Type Data 

 
Variable dan type data merupakan hal penting dalam pemrograman android mengapa? 

Karena variable merupakan memori tempat ditetapkanya sebuah nilai. Sedangkan untuk 

mendeklarasikan sebuah variable maka harus menetapkan tipe data terlebih dahulu. 

Untuk mencoba operasi pilih file selanjutnya new selanjutnya java project selanjutnya 

isikan nama project java sesuai anda. 

Kemudian tambahkan class hasilnya sebagai berikut ; 

 

 
 

1. Integer 
 

 
Hasil dari run integer tersebut 

 

 

2. Short integer 
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Hasil run dari short integer tersebut 

 

 

 
3. Int integer 

 

 

 
 

 
Hasil run dari int integer tersebut 

 

 
 

4. Bilangan pecahan seperti bilangan riil pada fungsi perhitungan.sama seperti byte,short 

float double perbedaan hanya pada memory dalam array 
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Hasil run program bilangan pecahan tersebut 
 

 

 
 

 

 
5.karekter mewakili simbul karakter seperti tulisan dan angka,digunakan juga seperti integer 

sehingga dimungkinkan untuk menamah dua karakter bersama. 
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Hasil run dari aplikasi karakter tersebut 
 

 

 
 

 
6 boolean merupakan tiype data untuk bersama logika yang bernilai benar atausalah 

digunakan operator if,while, do, dan sebagainya. 

 

 

 

 
Hasilnya run aplikasi di atas tersebut 
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3.2. Operator –Operator Perulangan dan Percabangan 

1. Operator aritmatik 
 

 
Hasil di run aplikasi di atas tersbut 

 

 

 
2. Operator perbandingan digunakan untuk membandingakan 2 nilai.hasil dari operator ini 

adalah benar atau salah 
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Hasil run aplikasi tersebut 

 

 
3. Perulangan disebut juga dengan looping yaitu mengulangi blog program sampai 

mencapai kondisi yang di inginkan 
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Hasil perulangan loop ketika di run 
 

 

 
 

 

 
4. Perulangan while adalah perubahan yang jika kondisi while terpenuhi bernilai true. 

Bentuk umum while adalah sebagai berikut 
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Hasil perulangan while program di atas 
 

 

 
 

 

 

6. Percabangan if merupakan aliran eksekusi program berdasarkan kondisi tertentu. Bentuk 

if statemen dipakai bersamaan dengan els. 
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Hasil run pecabangan if program di atas 
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BAB 4 

 
RELATIF LAYOUTE DAN LINEAR LAYOUTE 

 
4.1. Relatif Layoute 

 
Materi : Relative Layout dan Text View 

 

 

 
Lanjutan Menggunakan @string 

 

Metode 

Hardcod

e 

Pengatura

n String 

Value 

Metode 

String 
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4.2. Linear Layoute 

Tampilan linear layout seperti pada gambar, kamu perlu banyak berlatih untuk 

mengetahui perbedaan mendasar linear layaout dan relative layout tanpa harus melihat 

script code . 

 

 

1. Jalankan eclipse, file selanjutnya new selanjutnya android project/ 
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2. Isikan kotak dialog pada new seperti berikut 
 
 

 

 
4. Pilih linear layaout sederhana / res/layouth/ main,xml. 

 

 

 
5. Ketikkan kode berikut ini pada software eclipse Meskipun panjang, script ini nantinya 

memiliki kemiripan. Sementara cukup tulisan satu pola saja, selanjutnya lakukan 

copy paste edit untuk mempermudah. 
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Layout main.xml jika dilihat hierarkinya dari outline dibawah ini tampak seperti gambar 

 

 

 

 
10. Lakukan run dengan shortcut CRTL+F11 atau klik kanan package selanjutnya run as 

selanjutnya android project 

 

 

Sebuah aplikasi mobile android dibuat dari kombinasi java danxml biasanya xml di 

gunakan untuk mengatur layout aplikasi sedangakan yang java berperan sebagai pusat 

pengendalianya pembahasan dibagian ini focus pada xml yang ada. 
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Lihat main.xml yang ada pada bariske2.layoute di awali fiture widget linear layout, 

widget ini berperan sebagai parent yang secara otomatis nya terset vertical,artinya jumlah 

widget yang ada didalamnya tersusun secara otomatis vertical dari atas ke bawah, lihat 

perhatikan masing-masing parent linear layout memiliki 2 buah child yaitu linear 1 dan linear 

2, yang nantinya masing- msing child tersebut membunya masing-masing child karena parent 

linear layaout orintentationya vertical atas ke bawahdan linera 2 tersesusn secara vertifak atas 

dan bawah. 

Saat ini bisa kita amati penggunaan linear layout memiliki 4 fiture child text berisi 

conten merah,hijau, biru dan kuning. Orientasi linear layaoute disetting horizontal sehingga 

efek 4 warna text susunan berjajar ke kiri kanan. Masing-masing text view lebarnya di attur 

wrap content agar bisa menyesuaikan tempat panjang content masing-masing di dalamnya, 

sedangkan tinggi diattur fill parent sehingga dapat member efek tinggi masing-masing sesuai 

ruangan linear yang ada. 

Atribut pada gravityb text view mengakibatkan tulisan menjadi merah, hijau,biru dan 

kuning . posisinya semula ada ditengah secara garis horizontal. hal serupa juga terjadi pada 

linear layaout yang ada, hanya saja settingnya ada perbedaan. 

5.1.Membuat ScrollView 

 
Buat Project ScrollView. 

 
Drag (Klik tahan geser) file foto man.JPG ke res/drawable-mdpi 

Akan muncul jendela pilihan, silahkan pilih Copy Files 

Buat layout menjadi seperti ini : 
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Program selesai silahkan untuk me Run program sebelumnya jalankan emulatornya 

terlebih dahulu pada windows (android virtual manager) jika belum. 
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Lihat hasilnya pada emulator 
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BAB 5 

 
FUNGSI DASAR BUTTON 

 
 

5.1. Definisi Button 

Button merupakan fiture perangakat user interface pada andoid yang terdiri dari tombol, 

button merupakan salah satu fiture yang wajib ada pada aplikasi android karena peran nya 

dan aktivitas pada android banyak membutuhkan fiture button untuk mengeksekusi atau 

action ke perintah-perintah selanjutnya, seperti contoh tombol log ini ,tombol log out, 

pencarian dan menu- menu lain . 

5.2. Dasar Button 

1. Buat Android Application Project => Application Name dan Project name = Dasar Button 

2. Minimum SDK = Android 2.2 Froyo, 

3. Target dan Compile = Android 2.33 Gingerbread. 

4. Activity Name (.Java) = MainActivity.java 

5. Layout (XML) = main_activity.xml 

 



activity_main.xml 

 

6
2 
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MainActivity.java 

 

 

 

 
. 
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BAB 6 
 

RADIO DAN IMAGE 

6.1. Radio Dan Image 

Tujuan dari pembelajaran kali ini adalah untuk memperlajari bagaimana button bekerja. 

Skenario : User diberikan beberapa pilihan dan hanya dapat memilih satu pilihan. Kemudian 

user mengklik tombol hasil. 

Jalankan eclipse :file selanjutnya new selanjutnya android Project 

Isikan kotak pada dialog menjadi seperti ini 

Buka Checkbox/Res/layout/main_activity.xml 

Isikan kode seperti dibawah ini 
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Gambar harus dimasukkan kedalam folder res/drawable..sesuai dengan resolusi yang 

diinginkan. Untuk memasukkan file gambar ke folder res/drawable (pilih salah satu folder) 

misal drawable-ldpi caranya drag (klik tahan geser) file gambar dari sumbernya kemudian 

masukkan ke dalam folder res/drawable-ldpi .jika ada peringatan pilih copy files 
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Untuk dapat menggunakan button maka harus di buat kodenya pada MainActivity.java 
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Perhatikan android:id pada checkbox dan button. Perhatikan pula besar kecilnya. Id 

tersebut digunakan untuk memproses hasil pada MainActivity.java. 

Ingat dalam button jangan sampai keliru antara button:id dengan android:onClick 

 
Program selesai silahkan untuk me Run program sebelumnya jalankan emulatornya 

terlebih dahulu pada windows(android virtual manager) jika belum. 
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Perhatikan hasilnya ! 

 
Jika sudah berhasil running di emulator edit potongan dibawah ini 

 

 
Run program … 

 
6.2. Button dan Check Box 

Tujuan dari pembelajaran kali ini adalah untuk memperlajari bagaimana button bekerja. 

 
 

Skenario : User diberikan beberapa pilihan dan dapat memilih lebih dari satu pilihan. 

Kemudian user mengklik tombol hasil. 

Tampilan yang akan kita buat seperti dibawah ini : 
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Jalankan eclipse :file selanjutnya new selanjutnya android Project 

Isikan kotak dialog dibawah menjadi seperti ini : 

Buka Checkbox/Res/layout/main_activity.xml 

Isikan kode seperti dibawah ini 
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Untuk dapat menggunakan button maka harus di buat kodenya pada MainActivity.java 
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Perhatikan android:id pada checkbox dan button. Serta android:onClick="klikHasil" 

Perhatikan pula besar kecilnya. Id tersebut digunakan untuk memproses hasil pada 

MainActivity.java 

Program selesai silahkan untuk me Run program sebelumnya jalankan emulatornya 

terlebih dahulu pada windows (android virtual manager) jika belum. 
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6.3. Spinner dan Dialog 

 
Buat projek Mahasiswa 

 

Script layout activity_main.xml 
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Script MainActivity.java 
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BAB 7 

PENGANTAR ACTIVITY 

7.1. Pengantar Activity 

 
Kita akan membuat halaman utama yang mempunyai button untuk memanggil halaman 

yang 

lain. 

 

 
 

 

Halaman 
1 

Halaman 3 Halaman 2 

Halaman 1 

Halaman 3 

Halaman 2 
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Jalankan eclipse :file selanjutnya new selanjutnya android Project 

Isikan kotak dialog menjadi seperti ini : 

Dalam memanggil activity menggunakan intent maka perlu adanya event yang saling 

berhubungan antara layout, activity (.java) dan androidmanifest.xml 

 

 
Lihat struktur yang akan dbuat nanti 
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Drag file foto abid.jpg ke drawable-ldpi serta stekom.png pada drawable-mdpi 

Buat layout baru untuk halaman1, halaman 2, dan halaman infromasi caranya pada folder 

Res/layout diklik kanan new other  android xml file 
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Klik finis 

 
Buat juga untuk hal2, dan halinfo 

 

 

 

 
Ketikkan koding dibawah ini pada activity_main.xml 
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Pada layout / page1.xml ketikkan koding dibawah ini : 
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Pada layout/page3.xml ketikkan koding dibawah ini : 
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Setelah kita membuat layoutnya. kita buat class java. Untuk mengatur agar tombolnya 

dapat di klik dan memanggil activity hal1.java/hal2.java/hal3.java. dan activity tersebut akan 

meload layout yang dituju. 

Buat kelas hal1.java 
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Buat juga untuk hal2.java dan halinfo.java 

 

 
Edit kode program hal1.java menjadi seperti ini 
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setContentView(R.layout.hal1); 

} 

} 
 

Edit kode program hal2.java menjadi seperti ini 

 

 
 

Edit kode program hal2.java menjadi seperti ini 

Meload 

hal1.xm

l 
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Agar tombol pada activity_main.xml dapat bekerja maka harus dibuat program untuk 

Masukkan kode dibawah ini pada ActivityMain.java 
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Program selesai silahkan untuk me Run program sebelumnya jalankan emulatornya 

terlebih dahulu pada windows (android virtual manager) jika belum. 

 

 

Perhatian : jika dalam penulisan coding terdapat tanda lampu silang merah pada sisi 

kiri. Maka kita diminta untuk mengimport library. Silahkan di klik dan pilih import …. 
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7.2. Belajar Mengirim Data Menggunakan Intent 

Intent ini biasanya digunakan untuk interaksi antar komponen pada sistem operasi 

Android. 

 

 

 
Intent adalah objek dari paket paket android. Intent ini bisa digunakan untuk jembatan 

interaksi antar komponen dalamsyarat sistem operasi android dan bisa di lihat darigambar di 

atas. 

Penghubung yang di maksdu di sini adalah bahasa pemrograman banyak menyebut 

runtimg antar komponen atauobjek , inten banyak manfaat tetapi kabanyakan digunakan 

untuk penghubung activity sajadalam suatu aplikasi maupun interaksi antar activity beberapa 

aplikasi. 

Misal dalam membuat sebuah aplikasi pesan text. Dalam aplikasi tersebut kita bisa 

membuat menjadi beberapa activity untuk masing – masing proses, seperti: 

Activity Inbox berfungsi untuk meloading email – email yang masuk, 

Activity Compose berfungsi untuk meloading halaman menulis pada email, 

Activity Success berfungsi untuk menampilkan halaman sukses kirim pada email, 

Activity Sent berfungsi untuk meloading halaman email terkirim, 

Dalam latihan kali ini kita akan membuat sebuah aplikasi sederhana untuk mengirim data 

menggunakan intent 
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Berikut adalah project explorer yang kita buat : 
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activity_secondary.xml 
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Sekarang kita edit MainActivity.java 
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} 

 

 

 

 
Buat activity baru bernama SecondaryActivity.java 
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BAB 8 

SPLASH SCREEN 

8.1.Pengantar Splash Screen 

 
Kita akan membuat sebuah tampilan awal yang akan bertahan selama 5 menit dan 

kemudian secara otomatis akan tampil ke menu utama. Dalam latihan kali ini juga 

dicontohkan penggunaan Toast (pesan informasi dalam bentuk teks) serta Alert dialog (pesan 

popup). 

 

 

 

 

 

 

 

 

 

 

 

 

 
Pertama silahkan buat Project baru 

 
File  new Project , seperti biasa buat nama aplikasi dan minimum SDK 
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Buat ikon untuk shortcut 

 

 
Tampilan package 

 

 
Terlebih dahulu silahkan drag gambar bagron.jpg kedalam res/drawable-hpdi dan 

gambar stekom.png ke res/drawable-mdpi 
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Buat acivity_menu.xml 

Buat MenuActivity.java 

Masukkan kode activity_main.xml 

 

Masukkan kode pada acivity_menu.xml 
 
 

 

 

Masukkan kode program dibawah ini pada MainActivity.java 
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Agar MenuActivity.java dapat diakses daftarkan pada Androidmanifest.xml 

 

 

 
 

 

 

 

Selesai. Silahkan run Program 
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BAB 9 

PENGANTAR SQLITE 

9.1. Pengantar Sqlite 

 
Sistem informasi tidak terlepas dari penyimpanan database,mengapa memerlukan 

tempat penyimpanan database? Dikarenakan harus ada penyimpanan data atau informasi 

yang cukup besar dalam suatu sistem, baik itu aplikasi desktop,aplikasi mobile atau berbasis 

website harus adadatabase nya.dalam materi kita menggunakan sqlite sebagai tempat 

penyimnanan data karena sqlite adalah database internal DBMS yang tidak memerlukan 

server dan size yang digunakan cukup kecil namun memiliki kemampuan yang sangat kokoh 

dan penyimpanan besar,sehingga cocok di gunakan untuk aplikasi mobile,desktop atau 

website. 

Seperti database pada umunya yang ada sqlite memiliki objek-objek seperti table view 

dan index.perintah perintah sqlite memiliki kemiripan dengan SQL dalam penggunaanya. 

Yaitu select selanjutnya insert selanjutnya update selanjutnya dan  delete dan sebagai dari  

lain nya. informasi mengenai database sqlite dapat dibaca dan di pelajari secara lengkap pada 

situs resminya . 

 

 
Pada dasarnya aplikasi dengan fiture berupa database tidak menyertai database yang 

sudah dimiliki dalam berbentuk pada aplikasi itu di install perangkat bahasa java . Jadi yang 

di konfigurasi hanya program yang ada. sedangkan databasenya yang tidak ada sama sekali. 

Database nantinya akan di buat pada saat aplikasi itu berjalan untuk pertama kalinya,yaitu 

saat program ini akan memeriksa apakah database ditemukan. Atau jika ditemukan database 

maka serangkaian perintah fungsi SQL yang ada akan menjalankan lagi perintah fungsi create 

yang akan membentuk file itu sendiri , dalam perintah fungsi SQL tersebut secara lebih 



102 
 

spesifiknya sesuai struktur data yang ada di dalam aplikasi tersebut. Ini adalah salah satu 

tenik yang biasanya digunakan para programmer dalam membuat sebuah aplikasi atau project 

dengan embed fungsi database dimana tidak menyertakan file database asli di dalam paket 

aplikasi yang dibuat tersebut. 

Berikut ini diperlihatkan sebuah contoh program menggunakan SQLite. 

Nama project : Dasar SQLite 
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SQLiteHelper.java 

Nama 
database 

Otomatis Membuat 
database 

jika belum ada 

Upgrade versi database 
jika 

versi database dinaikkan 

Script untuk tambah 

data perhatikan nama 

method dan 

attributnya 
 

(public void tambah….. 
) 

Nama 

field/kolom 



104 
 

activity_main.xml 

 

 
MainActivity.java 
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tambah_data.xml 

 

 
TambahData.java 
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AndroidManifest.xml 

Tambahkan script dibawah ini 

 

 
9.2. Menampilkan Data menggunakan SQLite Browser 

 
Untukmelihat data pada database SQLite pada emulator, tambahkan plugin 

com.questoid.sqlitebrowser_1.2.0.jarkedalam folder plugin. 
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1 

2 

3 

   4  

5 

(open file in SQLite 
Browser) 
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7 6 
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BAB 10 

 
CRUD DATABASE SQLITE 

 

10.1.Crud Database Sqlite 
 

 
Tambahkan method untuk update data dan hapus data berikut ke dalam file 

SQLiteHelper.java 
 

 
 

Activity baru 

Layout baru 



110 
 

Edit file Tampil Data Detail.java untuk menambahkan Method Klik Edit dan Klik Hapus 

tambahkan kode berikut ini 

 

 

Ubah jenis menjadi Global Variable 

agar dapat digunakan pada method 

lain selain Method OnCreate 

Membuat object dari kelas 
SQLiteHelper.java 

Menuju TampilData.Java 

Menggunakan method 

hapus_barang pada 
SQLiteHelper.java 

Menuju 

EditData.java 

dengan extra 

value 



111 
 

edit_data.xml 

 

No 
editable 
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EditData.java 
 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

Variable 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Menampilkan 

nilai kedalam 

EditText 

 
 
 

 
 
 
 
 

Menggunakan 

method 

update_barang pada 

SQLiteHelper.java 

Fungsi kembali ke 

Activity 

sebelumnya 

(back) 
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BAB 11 

MENAMPILKANDATA DATABASE SQLITE 

11.1.Menampilkan Data Database Sqlite 
 

 
Tambahkan method berikutkedalam file SQLiteHelper.java 

 

 

TampilData.java 

Activity baru 

Layout baru 
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ListAdapter.java (list adapter digunakan untuk men-generate tampilan menjadi list / 

berurutan kebawah) 

Memanggil Activity 

TampilDataDetail.java 

denganmembawa 4 

nilai 
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Nama layout 

yang digunakan 
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list_tampil_data.xml 

 

 
TampilDataDetail.java 

 

tampil_data_detail.xml 

Mengisi id denganteks 
yang 

diperoleh 

Mengambilnilai yang 

dikirimmenggunakan 

intent 

Deklarasi id 
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